
Pro Tools 10 – What’s new! 

 

Avid  now offers two main versions of its Pro Tools software – the high-end Pro 

Tools 10 HD (which is still only sold  with Avid  hardware but can be used  

without this) and  standard  Pro Tools 10 software (which can be purchased  

separately or with Avid  hardware). 

 

Anyone who has been using versions 8 or 9 of Pro Tools will appreciate that the 

changes to the user interface in Pro Tools 10 are minimal. So if you know how to 

work with these earlier versions, you will find  it very easy to get up-to-speed  

with Pro Tools 10.  

 

Technical Enhancements 

 

Lots of technical enhancements make Pro Tools 10 much more responsive to use 

and  generally speed  up workflow.  

 

For example, fades are now calculated  and  played  back in realtime, so no more 

waiting for fades to get re-built! Sessions open faster and  fades are now instant 

even with the longest fades.  

 

Automatic Delay Compensation (ADC) now has four times the number of 

samples (16,384) so you can hand le bigger mixes, no matter how many plug-ins 

you use. The original PT HD systems were (and  still are) limited  to 4096 samples, 

but the new Pro Tools| HDX systems and  all other Pro Tools systems can use the 

larger limit. 

 

Another convenient new feature is the ability to export selected  tracks from a 

session as a new session. Previously, it was possible to import selected  tracks 

from any other session, but not vice versa. 

 

A completely new disk engine has been developed for Pro Tools HD and Pro 

Tools 10 that greatly increases performance for audio record ing and  playback. As 

a consequence: 

 

•  The DAE Playback Buffer Size setting provided  in the Playback Engine in 

lower versions of Pro Tools is no longer necessary and  has been removed.  

 

•  For Pro Tools software only (not for PT HD), the Cache Size setting h as 

been removed.  

 

•  Open-Ended Record  Allocation settings provided  in the Operation 

Preferences in lower versions of Pro Tools are no longer necessary and  have been 

removed. 



 

Track counts have also been improved for Pro Tools 10, which will play back up 

to 96 tracks at 44.1/ 48 kHz and can record  up to 32 tracks simultaneously if your 

interface has enough inputs. It also provides up to 64 virtual instrument tracks, 

512 MIDI tracks, 160 auxiliary tracks, 256 busses and  one video track. 

 

With PT HD 10 software or Complete Production Toolkit at 44.1 or 48 kHz you 

can record  or play back 256 simultaneous tracks using any hardware, apart from 

with the original HD - which only allows 192 simultaneous playable tracks.  

 

Plug-ins are now referred  to as Native or DSP and there is a new (64-bit ready) 

plug-in format - AAX (Avid  Audio eXtension). This uses the same software code 

for both AAX DSP and AAX Native versions, so these sound the same - which is 

not the case with TDM vs RTAS. Eventually, when the 64-bit version of Pro Tools 

appears, RTAS and TDM plug-ins will become obsolete and  the AAX format will 

be the only format for Pro Tools. 

 

AudioSuite Enhancements 

 



 
 

•  Two AudioSuite windows open: the Mod Delay III has been ‘untargeted’ to allow the 

Channel Strip (shown in its ‘targeted’ state) to be opened at the same time. 

 

Pro Tools 10 conveniently lets you open multiple AudioSuite windows at the 

same time. Just like real-time plug-in windows, AudioSuite windows now have a 

target button. If you click on an active target button to „untarget‟ a window, this 

window will remain open if you open additional plug-in windows. Using 

„targeted‟ plug-in windows (which have the target button highlighted  in red) you 

can switch between d ifferent AudioSuite plug-ins - to receive keyboard  input for 

these, for example. 

 

Pro Tools 10 now lets you render clips with AudioSuite plug-ins while including 

“handles” (add itional regions that are not initially visible) that extend  beyond 

the current Edit selection from 0.00 to 60.00 seconds, or can even encompass the 

whole file referenced  by the clip . This feature allows you to trim clips out past 

the rendered  selection after you have processed  your selection using an 



AudioSuite plug-in. This capability can be very useful when you are „fine-tuning‟ 

the ed it points to match up to ad jacent material. 

 

 
 

•  Default Handle Length set to 2.00 Seconds in the Processing Preferences window. 

 

In lower versions of Pro Tools, AudioSuite processing only affects the current 

Edit selection and  creates a new file of the exact same length. The resulting 

region (clip) cannot be trimmed out beyond the processed  selection. However, 

with Pro Tools 10, the resulting rendered  clip  can be trimmed out to the specified  

handle length, or even up to the whole file referenced  by the original clip  (if the 

Whole File option is selected  before rendering). 

 

Pro Tools 10 also provides a new Reverse button in the AudioSuite plug-in 

window footer for Reverb and  Delay plug-ins. This lets you easily render reverse 

delay and  reverb effects with a single click. Clicking the Reverse button first 

reverses the Edit selection. Then, it processes the reversed  Edit selection with the 

current plug-in settings. Finally, it reverses the processed  Edit selection. 

 



New Audio File Formats and Features 

 

Pro Tools 10 can now record  and  play back at d ifferent bit-depths within the 

same session and  you can record  files with d ifferent bit -depths within a session 

at d ifferent times by simply changing the bit-depth in the Session Setup window.  

 

Support is provided  for multiple file types all within the one session as well. So 

you can import WAV, AIFF and SDII formats and  they can be used  without any 

need  for conversion to the session format (which can be either AIFF or WAV).  

 

Pro Tools 10 also has support for 32-bit floating-point file formats, so you‟ll get 

higher resolution sound when record ing or importing, with more headroom to 

preserve the integrity of your audio from beginning to end .  

 

Note: You wouldn‟t want to use 32-bit files unless you have a very fast system 

with very fast hard  drives, because they take up more d isk space and  need  more 

audio streaming bandwidth. 

 

You can now use interleaved  stereo files in Pro Tools. Previously you had  to use 

mono or linked  mono files, such as a left and  right mono pair for stereo files. This 

helps save space because previously, if you brought interleaved  files into Pro 

Tools, they would  be converted  to linked  mono files – so you needed extra space 

for this.  When you check Interleaved  in the Session setup box, new  stereo files 

that you record  will be interleaved . You can always bring in interleaved  files. So 

you can change this setting any time you like. 

 

Pro Tools 10 supports two new audio file formants – WAVE Extensible and  RF64. 

The WAVE Extensible file format, WAV (BWF EXT), specifies multiple audio 

channel data for surround sound along with speaker positions, which is stored  

within the audio file header. RF64 is an extension to the WAV audio file format 

that addresses the 4 gigabyte size limitation of other WAV audio file formats.  

 

Note that to use these files in a lower version of Pro Tools or in Media Composer, 

these files need  to be ed ited  and  consolidated  so that they are not larger than 4 

GB. 

 

Clip Gain 

 

One of the most important new features is Clip Gain. But what‟s a „clip‟? You 

may have heard  of video „clips‟, which are short sections of video, usually part of 

longer record ings, or perhaps just short video record ings. Audio clips are the 

same thing, but just contain audio. This usage of the work „clip‟ is typically 

found in media production, which is what Avid  is all about, as opposed  to audio 

or music production - which was what Digidesign, the original manufacturer of 



Pro Tools, was all about. So what were formerly referred  to as „regions‟ in Pro 

Tools, are now called  „clips‟, and  the Region menu has been renamed 

accordingly. 

 

Each clip  can have its own gain value, independently of the track volume, 

automation settings or whatever. At the bottom left of each clip  you can d isplay a 

small fader icon by selecting Clip Gain Info from the View menu. Every clip  has 

its own gain fader and  the waveform will look bigger or smaller when you raise 

or lower the gain – great visual feedback! You can d isplay a Clip Gain Line on 

each clip , selectable from the View Menu, and  just use the trim tool to drag this 

up and  down to set the level. You can turn clip  gain into automation and  vice 

versa with HD software or CPT. Clip gain settings can also be automated  by 

setting breakpoints on the Clip Gain Line using the Pencil tool.  

 

The big new thing here is that you can go through your entire lead  vocal track, 

for example, make each phrase (or even each word) into an individual clip , then 

instantly and  conveniently ad just its level to make the entire vocal „sit‟ properly 

in the track.  

 

 
 

•  Pro Tools 10 Edit Window show four clips, each with Clip Gain applied and Clip Gain 

Lines displayed. 

 

Post-production enhancements: 

 



Pro Tools is widely used  for post-production for TV, video and  film, so it makes 

sense that Avid  has included  several enhancements to make life easier for post-

production engineers.  

 

One of the most important changes is that Pro Tools 10 now provides a full 24-

hour Timeline – and  this is available at all sample rates. So, as the manual 

explains, “You can now set a SMPTE Start Frame for your session at any location 

in the Timeline and  it can cross from 23:59:59:29 to 00:00:00:00 (commonly 

referred  to as the “midnight” boundary). This is useful when working with 

multiple reels compiled  at hour intervals, and  when w orking with d ialog that is 

spotted  to time-of-day (TOD) timecode. In lower versions of Pro Tools and  with 

Avid  Media Composer, the Timeline is limited  to just under twelve hours at 44.1 

kHz and 48 kHz sample rates, and  just under six hours at 88.2 kHz and 96 kHz.” 

 

Avid  has also paid  attention to the terminology used  in its Digidesign products 

to make this more consistent. For example, to make these fall in line with the 

terminology used  in Avid‟s video products, the Pro Tools Edit selection Start and  

End points are now called  the In and  Out points and  the Process function is now 

called  the Render function. 

 

New User Interface Features and Enhancements: 

 

Pro Tools 10 now provides a visual ind icator in the Edit window to show 

whether or not the Automation Follows Edit option is enabled  and  you can 

simply click the indicator to enable or d isable this option. In previous version of 

Pro Tools, you had  to view this in the Options menu to see if it was ticked  or not. 

 

It can be quite a daunting task to remember exactly which tracks are solo-ed  or 

muted , and  which tracks use a specific input, internal bus, output bus, or 

hardware insert. Of course, if you are using a large mixing control surface this 

will be easier than when you are working „in the box‟ with many more tracks 

than can be d isplayed  at the same time on your computer screen. 

 

To make things easier, Pro Tools 10 provides two new visual ind icators in the 

Edit window that let you quickly check whether or not any tracks in the session 

are soloed  or muted . This is especially useful for sessions with lots of tracks 

where tracks that are soloed  or muted  may be scrolled  out of view. 

 

The Track Solo Indicator lights yellow when any track in the session is soloed . It 

lights d im yellow when a track is soloed  on any satellite system, and  if no tracks 

are soloed , it appears d im green. Very conveniently, if the Track Solo indicator is 

lit, you can click it to clear all solo‟d  tracks in the session.  

 



The Track Mute Indicator lights orange when any track in the session is muted . 

When no tracks in the session are muted , the Track Mute indicator appears d im 

green. However, because Mute is an automatable mixing function, the Track 

Mute indicator does not clear all the mutes when clicked . 

 

Pro Tools 10 also provides a new Bus Interrogation feature that lets you select or 

show tracks based  on the track input or output assignment, send  assignment, or 

hardware insert assignment. This lets you quickly identify all the tracks that use 

a specific input, internal bus, output bus, or hardware insert. 

 

When you right-click the assignment selector you are presented  with four 

options: 

 

1/  „Select Assignments To‟ selects all tracks that use a specific input, internal 

bus, output bus, or hardware insert.  

 

2/  „Show Assignments To‟ shows all tracks, including hidden tracks, that use 

a specific input, internal bus, output bus, or hardware insert. All other tracks 

remain shown as well.  

 

3/  „Show Only Assignments‟ To shows only those tracks that use a specific 

input, internal bus, output bus, or  hardware insert. All other tracks are 

automatically hidden.  

 

4/  „Restore Previously Shown Tracks‟ restores the previous state of shown 

and hidden tracks. This option is only available if tracks have been hidden by 

using the Show Only Assignments To option. 

 

Low Latency Monitoring with Core Audio and ASIO Hardware 

 

With Pro Tools and  Pro Tools HD 10, you can now use the Low Latency 

Monitoring option to record  with an extremely small amount of monitoring 

latency with Core Audio and  ASIO audio interfaces that have a built-in mixer 

(such as the RME Fireface or the MOTU 828). Only tracks with inputs set to an 

audio interface (not a bus) use Low Latency Monitoring.  

 

However, if your Core Audio or ASIO hardware does not have a built -in mixer, 

Low Latency Monitoring will not work. Also, if you are using a Mac computer, 

the Pro Tools Aggregate I/ O does not support the Low Latency Monitoring 

option. 

 

To use Low Latency Monitoring, you must assign each track output to either 

Output 1 or Output 2 (mono), or Output 1–2 (stereo) and  make sure that Low 

Latency Monitoring is selected  in the Options menu. Pro Tools then d isables 



software monitoring for record -enabled  tracks routed  to Outputs 1–2. This lets 

you use the built-in mixer function on your Core Audio or ASIO hardw are for 

record  monitoring with Outputs 1 and  2 on your Core Audio or ASIO audio 

interface. 

 

Improved Disk Storage Support 

 

Avid  has significantly improved  Pro Tools 10‟s disk storage capabilities, with 

enhanced  support for RAID (redundant array of independ ent d isks) systems, 

Network Attached  Storage systems, and  Avid  shared  storage systems. 

 

Previous versions of Pro Tools only support software-based  RAID systems using 

ATTO RAID software (which makes several RAID volumes appear as a single 

volume to the operating system). Pro Tools 10 additionally supports hardware-

based  RAID systems for opening, playing back, and  record ing Pro Tools 

sessions.  

 

Note: Performance with RAID systems is not guaranteed  and  is dependent on a 

variety of factors including network bandwidth, so you should  still be using fast, 

d irectly connected , single hard  drive systems as your primary record ing d isks 

whenever possible. 

 

Pro Tools 10 will open, play back and  record  Pro Tools sessions with  all Mac OS 

X and Windows 7 supported  Network Attached  Storage systems, although, as 

with RAID systems, performance is not guaranteed . Pro Tools 10 also offers 

several improvements when working with Avid  Unity MediaNetwork and  ISIS 

Shared  Storage systems. With Avid  Unity Media-Network and  ISIS 7000 you get 

increased  track counts and  Mac streaming support. Streaming support has been 

added for ISIS 5000 and Elastic Audio processing is now supported  with all Avid  

shared  storage systems. 

 

Note: Exact track counts will vary depending on session size and  amount of 

RAM allocated  to the Disk Cache – so if you have spare RAM available, increase 

the size of the Disk Cache. 

 

More new stuff… 

 

Pro Tools can bounce a file and  import it d irectly into iTunes or upload  it to 

SoundCloud. You can bounce as an MP3 or as a 24-bit WAV, or whatever. If you 

bounce to iTunes, Pro Tools puts this into iTunes automatically in the 

background, ready for you to play whenever you like.  

 

Pro Tools now provides easy access to the online Avid  Store, as well as web-

based  Pro Tools Help, the Knowledge Base, and  other online resources using two 



new in-application Web browsers: Avid  Marketplace, which provides a secure 

web connection to Avid‟s online commerce web pages for Pro Tools, and  Pro 

Tools Online, which provides easy access to web based  Pro Tools Help, the 

Knowledge Base, and  Avid  audio community forums. 

 

The new Avid  Channel Strip  looks set to be another „crowd -pleaser‟ for PT10 

users, with EQ, Dynamics, Filter and  Gain effects that use processing algorithms 

based  on those of the highly regarded  Euphonix System 5 console. In action, the 

Strip  is great for working on lead  vocals, provid ing much better visual feedback 

and  control than the standard  plug-ins. 

 

New features in Pro Tools HD 10 

 

For large-scale projects, such as film scoring, you will want to be using Pro Tools 

HD10 software with high-end hardware. PT HD10 is specially designed  to work 

with the new Pro Tools| HDX systems (or with Pro Tools| HD Native systems) 

but can also be used  with third -party equipment. 

 

The new PT| HDX card  delivers up to five times more DSP per card , has over 

1,000 dB of additional headroom, up to four times the track counts and  double 

the I/ O (with up to 64 channels of I/ O per card) compared  to its Pro Tools| HD 

Accel predecessor. 

 

PT HD10 software gives you everything that you get in Pro Tools 10 software 

plus lots more: it will play back up to 256 tracks at 44.1/ 48 kHz and can record  

up to 256 tracks simultaneously if your hardware has enough inputs. It provides 

up to 128 virtual instrument tracks, 512 MIDI tracks, 512 auxiliary tracks, 256 

busses and  64 video tracks. So a 3-card  HDX system can play up to 768 tracks at 

the same time!  

 

PT HD10 (and  PT10 with Complete Production Toolkit) let you load  audio files 

into RAM, prioritizing files closest to the current playhead  location, so when you 

hit „start‟, those files ready for playback. Consequently, these systems are much 

more responsive. This is especially useful when working with shared  media 

storage (such as with Avid  Unity MediaNetwork and  ISIS shared  storage 

systems), avoid ing delays in response that might otherwise occur. You will need  

plenty of RAM, of course.  

 

As the manual explains: “To determine the maximum amount of RAM available 

for Disk Cache, Pro Tools polls the computer for the amount of RAM installed  

and  subtracts 3 GB with Mac systems or 4 GB with Windows systems. For 

example, if your computer has 12 GB of RAM installed , the total amount of RAM 

available for the Disk Cache will be 9 GB (Mac) or 8 GB (Windows).”  

 



 
•  Pro Tools| HDX PCIe Card 

 

PT HD10 software upgrades start from £754.80 while the cost of a complete new 

HDX system is quite high, starting from £7558.80 for an HDX card  with Pro Tools 

HD 10 software. Crossgrades from older single, double or triple card  HD systems 

are similarly expensive, ranging from around £4,000 to trade up an HD3 system 

to closer to £6,000 if you only have an HD1 system. Pro Tools HD Native systems 

start to sound positively cheap at just over £2,000! 

 

So which should  you use? Obviously this depends on your budget , but Avid  has 

conveniently summarized  this from a technical perspective: “Choose the Pro 

Tools| HD Native system if you need  the advanced  workflows and  sound quality 

of Pro Tools HD software and  want to use your host computer to get the best 

performance and  lowest latency. Or choose the DSP-accelerated  Pro Tools| HDX 

system for consistent performance and  near-zero latency when working with 

extremely large, complex productions.”  

 

In Conclusion: 

 

Pro Tools 10 is much faster to work with than previous versions – sessions open 

faster and  everything feels more responsive. Editors will love the new Clip Gain 

features, and  all users will appreciate the new technical enhancements.  

 

If you are working in post-production, this update is a „must-have‟ with greatly 

improved control surface (EUCON) and worksurface (D-Command) integration.   

Prices for Pro Tools 10 are reasonable – the full version of the software retails for 

£598.80 and  the upgrade from Pro Tools 9 retails for £238.80. 



 

Music professionals will value the workflow and speed  enhancements – time is 

money – and  serious hobbyists can get to work with the same software used  by 

the top professionals at a relatively affordable price! 

 

System Requirements 

 

Mac 

 

•  Avid-qualified  Apple computer  

•  Mac OS X 10.6.8 or Mac OS X Lion 

•  Pro Tools: 2 GB of RAM (4 GB recommended); Pro Tools HD: 4 GB of RAM (8 

GB recommended) 

•  Minimum 15 GB free hard  d isk space for installation  

•  USB port for iLok authorization 

 

PC 

 

•  Avid-qualified  PC  

•  Windows 7 Home Premium, Professional, or Ultimate (32- or 64-bit) 

•  Pro Tools: 2 GB of RAM (4 GB recommended); Pro Tools HD: 4 GB of 

RAM (8 GB recommended) 

•  Minimum 15 GB free hard  d isk space for installation  

•  USB port for iLok authorization 
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